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Constraints
Constraints adalah cara untuk mengendalikan properti dari sebuah objek (lokasi, rotasi dan skala), 
menggunakan nilai statis dari objek itu sendiri maupun menggunakan objek lain atau yang disebut 
target.

Constraint pada software Blender dapat bekerja pada Objects dan Bone

Constraints dapat dikombinasikan dengan constraints lainnya dan membuat tumpukan contraints.

Constraints pada object.

Constraints pada rigging.

Susunan constraints dievaluasi dari atas ke bawah.



Tips
Constraints adalah cara yang fantastis untuk menambahkan complexity dan kecanggihan pada 
sebuah rig.

Tapi berhati-hati agar tidak terlalu terburu-buru dalam menumpuk contraints demi contraints 
sampai kita kebingungan dalam memahami bagaimana contraints itu berinteraksi dengan 
contraints lainnya.

Mulailah dengan sederhana, pahami satu contraints luar dalam. Contraints “copy location” adalah 
contraints awal yang baik untuk dipahami. Habiskan waktu untuk memahami konsep fundamental 
dibaliknya dan contraints lain akan lebih mudah untuk dipahami.

Getting Started
kita langsung saja mencoba untuk menggunakan constraint pada Bone. Sebelum kita mencoba 
untuk menggunakan constraints siapkan terlebih dahulu dua buah tulang.

1. Buat satu buah objek tulang

Mode	 : Object Mode
Menu	 : Add > Armature > Single Bone

2. Masuk ke Edit Mode kemudian duplikat 
tulang tersebut sehingga menjadi 2.
Mode	 : Edit Mode
Hotkey	 : Shift + D



Adding/Removing a Constraint

Mode	 : Pose Mode
Menu	 : Properties, Constraint Tab

Untuk menghapus constraint tekan tombol “x” di bagian header constraint.



Add Constraint

Mode	 : Pose Mode
Menu	 : Pose > Constraints > Add Constraint (with Targets)
Hotkey	 : Ctrl + Shift + C

Menambahkan constraint pada Bone yang sedang aktif. jika ada Bone lain yang aktif maka akan 
dijadikan sebagai target, jika tedapat properties target pada jenis constraint yang dipilih.

Copy Constraint to Selected

Mode	 : Pose Mode
Menu	 : Pose > Constraints > Copy Constraint to Selected Bones
Hotkey	 : -

Menduplikasi constraint dari Bone yang terakhir dipilih kepada Bone lain yang sebelumnya dipilih.

Clear Constraints

Mode	 : Pose Mode
Menu	 : Pose > Constraints > Clear Pose Constraint
Hotkey	 : Ctrl + Alt + C

Menghilangkan semua constraint pada Bone yang dipilih.



Constraint: Copy Location

Add Constraint

Mode	 : Pose Mode
Menu	 : Pose > Constraints > Add Constraint (with Targets) > Copy Location
Hotkey	 : Ctrl + Shift + C

Tampilan Bone yang telah diberikan constraint copy location.



Elemen Constraint

Header
Setiap constraint memiliki header. Elemen header yang akan dipelajari akan menggunakan 
constraint copy location.

Expansion Arrow (menunjuk ke bawah atau kanan)

Menunjukan atau menyembunyikan properti setting dari constraint. Merapihkan tumpukan 
constraint yang sedang tidak membutuhkan perhatian. Constraint akan tetap berfungsi walaupun 
sedang disembunyikan

“Copy Location”

Tipe dari sebuah constraint, yang akan muncul sejak pertamakali constraint dibuat.

“Copy Location” 

Memberikan nama tertentu pada constraint, nama yang mendeskripsikan maksud dari constraint 
tersebut sehingga memudahkan kita dan tim untuk memahami maksud dari setiap constraint. 
Warna merah memberikan peringatan bahwa constraint belum berfungsi secara benar. 
Background akan berubah menjadi abu ketika constraintnya berfungsi

Eyeball (open or closed)

Fungsi dari icon ini adalah untuk mengaktifkan dan menonaktifkan sebuah constraint. Constraint 
yang dinonaktifkan efeknya akan behenti bekerja. menonaktifkan sebuah constraint artinya 
mematikan efek tanpa menghilangkan pengaturan dari constraint tersebut. Sehingga nantinya kita 
dapat mengaktifkan kembali constraint dengan setting yang masih lengkap.

lokasi header berada di bagian atas di setiap constraint



Up/Down Arrows

Memindahkan constraint ke atas dan ke bawah pada tumpukan constraint. Penilaian sebuah 
tumpukan constraint terjadi dari atas ke bawah, sehingga memindahkan sebuah constraint yang 
berada di tumpukan akan memberikan perbedaan output yang signifikan. Jika hanya ada satu 
constraint maka icon panah tersebut tidak akan muncul.

X

Menghapus constraint dari bone. Setting yang sudah dibuat akan hilang, dan constraint tidak akan 
memberikan efek output apapun.

Umum

Target

Target atau kolom data ID membuat kita dapat menghubungkan constraint ke target bone yang 
dipilih. Sebagai contoh, kita dapat mengisi kolom target, dan constraint copy location akan mulai 
untuk menggunakan data lokasi dari bone yang dijadikan target.

Jika kolom target diisi dengan nama objek tulang contohnya “Armature”, maka akan muncul kolom 
Bone dan Head/Tail. Isi kolom Bone dengan sebuah nama tulang dan target dari constraint akan 
berubah menjadi spesifik ke satu tulang buka keseluruhan objek tulang. Slider Head/Tail berfungsi 
untuk merubah target constraint dari head ke tail atau diantaranya.



Space

Sebuah constraint membutuhkan sebuah frame dalam menjalankan fungsinya, dan frame ini ada 
“space” dalam constraint. Memilih satu space dengan space lainnya akan merubah referensi frame 
dan merubah perilaku dari constraint tersebut.

Influence

Influence slider akan mengatur seberapa banyak constraint akan berpengaruh terhadap target.

Tipe Space

World Space
Di tipe space ini World adalah referensi frame untuk objek atau bone. Lokasi menjadi relatif 
terhadap world origin. Rotasi dan Scale berorientasi kepada world axes.

Local Space
Pada tipe space ini, parent dari bone adalah referensi frame yang digunakan.

Local With Parent
Referensi frame yang digunakan adalah properti dari bone itu sendiri.

Pose Space
Referensi frame yang digunakan adalah local space dari objek armature bone tersebut.



Copy Location Constraint
Copy Location constraint memaksa objek pemiliknya untuk memiliki lokasi yang sama dengan 
targetnya.

Target
Kolom target digunakan untuk memilih target constraint, dan constraint tidak akan bekerja bila 
kolom target dikosongkan.

Bone
Ketika kita menjadikan objek tulang sebagai target, maka kolom Bone akan muncul untuk 
digunakan memilih secara spesifik bagian tulang mana yang akan dijadikan target.

X, Y, Z
Kolom ini mengendalikan axis mana yang akan diaktifkan pada constraint.

Invert
Kolom invert gunanya untuk membuat arah berlawanan dari axis yang digunakan pada constraint.

Offset
Ketika diaktifkan, kontrol ini membuat lokasi objek pemilik constraint menggunakan transformasi 
propertiesnya sendiri relatif pada posisi target.

Space
Kolom untuk memilih frame kerja.



Copy Rotation Constraint
Copy Location constraint memaksa objek pemiliknya untuk memiliki rotasi yang sama dengan 
targetnya.

Target
Kolom target digunakan untuk memilih target constraint, dan constraint tidak akan bekerja bila 
kolom target dikosongkan.

Bone
Ketika kita menjadikan objek tulang sebagai target, maka kolom Bone akan muncul untuk 
digunakan memilih secara spesifik bagian tulang mana yang akan dijadikan target.

X, Y, Z
Kolom ini mengendalikan axis mana yang akan diaktifkan pada constraint.

Invert
Kolom invert gunanya untuk membuat arah berlawanan dari axis yang digunakan pada constraint.

Offset
Ketika diaktifkan, kontrol ini membuat lokasi objek pemilik constraint menggunakan transformasi 
propertiesnya sendiri relatif pada posisi target.

Space
Kolom untuk memilih frame kerja.



Copy Scale Constraint
Copy Location constraint memaksa objek pemiliknya untuk memiliki skala yang sama dengan 
targetnya.

Target
Kolom target digunakan untuk memilih target constraint, dan constraint tidak akan bekerja bila 
kolom target dikosongkan.

Bone
Ketika kita menjadikan objek tulang sebagai target, maka kolom Bone akan muncul untuk 
digunakan memilih secara spesifik bagian tulang mana yang akan dijadikan target.

X, Y, Z
Kolom ini mengendalikan axis mana yang akan diaktifkan pada constraint.

Offset
Ketika diaktifkan, kontrol ini membuat lokasi objek pemilik constraint menggunakan transformasi 
propertiesnya sendiri relatif pada posisi target.

Space
Kolom untuk memilih frame kerja.



Latihan
Buka file Copy Constraint.blend, untuk mencoba membuat constraint copy location.



Limit Constraint

Limit Distance
Limit Distance constraint memaksa objek pemiliknya untuk berada jauh, dekat, atau di lokasi 
tertentu dari targetnya.

Target
Kolom target digunakan untuk memilih target constraint, dan constraint tidak akan bekerja bila 
kolom target dikosongkan.

Bone
Ketika kita menjadikan objek tulang sebagai target, maka kolom Bone akan muncul untuk 
digunakan memilih secara spesifik bagian tulang mana yang akan dijadikan target.

Distance
Kolom angka ini mengatur batasan jarak antara objek pemilik constraint dengan target. Dalam hal 
ini angka tersebut diterjemahkan sebagai radius dari target.

Reset Distance
Ketika ditekan tombol ini berfungsi untuk mengatur kembali agar nilai distance sesuai dengan nilai 
sesungguhnya dari jarak antara pemilik constraint dengan target.

Clamp Region
Fungsinya untuk memilih bagaimana cara kita menggunakan Sphere (Bola) sebagai tolak ukur 
penghitungan jarak, yang didefinisikan dengan pengukuran jarak dan pusat rotasi dari target.

	 Inside: Pemilik constraint berada di dalam sphere (bola)
	 Outside: Pemilik constraint berada di luar sphere (Bola)
	 Surface: Pemilik constraint berada di permukaan sphere (Bola)

Space
Kolom untuk memilih frame kerja.



Limit Location
Limit Location berfungsi untuk membatasi lokasi dari objek pemilik constraint.

Minimum X, Y, Z
Kolom ini berfungsi untuk memberikan nilai batas minimum bagi pemilik constraint. jika nilai 
minimum ini disi oleh angka yang lebih besar dari nilai maximum, maka fungsinya akan berubah 
dan bekerja sebagai nilai maximum bagi pemilik constraint.

Maximum X, Y, Z
Kolom ini berfungsi untuk memberikan nilai batas maximum bagi pemilik constraint. jika nilai 
maximum ini disi oleh angka yang lebih kecil dari nilai minimum, maka fungsinya akan berubah 
dan bekerja sebagai nilai minimum bagi pemilik constraint.

Convert
Kolom untuk memilih frame kerja.



Limit Rotation
Limit Location berfungsi untuk membatasi rotasi dari objek pemilik constraint.

Limit Minimum X, Y, Z
Kolom ini berfungsi untuk memberikan nilai batas minimum bagi pemilik constraint. jika nilai 
minimum ini disi oleh angka yang lebih besar dari nilai maximum, maka fungsinya akan berubah 
dan bekerja sebagai nilai maximum bagi pemilik constraint.

Limit Maximum X, Y, Z
Kolom ini berfungsi untuk memberikan nilai batas maximum bagi pemilik constraint. jika nilai 
maximum ini disi oleh angka yang lebih kecil dari nilai minimum, maka fungsinya akan berubah 
dan bekerja sebagai nilai minimum bagi pemilik constraint.

Convert
Kolom untuk memilih frame kerja.



Limit Scale
Limit Location berfungsi untuk membatasi skala dari objek pemilik constraint.

Minimum X, Y, Z
Kolom ini berfungsi untuk memberikan nilai batas minimum bagi pemilik constraint. jika nilai 
minimum ini disi oleh angka yang lebih besar dari nilai maximum, maka fungsinya akan berubah 
dan bekerja sebagai nilai maximum bagi pemilik constraint.

Maximum X, Y, Z
Kolom ini berfungsi untuk memberikan nilai batas maximum bagi pemilik constraint. jika nilai 
maximum ini disi oleh angka yang lebih kecil dari nilai minimum, maka fungsinya akan berubah 
dan bekerja sebagai nilai minimum bagi pemilik constraint.

Convert
Kolom untuk memilih frame kerja.



Latihan
Buka file Limit Constraint.blend, untuk mencoba membuat constraint copy location.



Inverse Kinematics (IK)
Constraint inverse Kinematics mengimplementasikan cara pose sebuah susunan tulang 
menggunakan kinematik terbalik.

Target
Kolom target digunakan untuk memilih target constraint, dan constraint tidak akan bekerja bila 
kolom target dikosongkan.

Bone
Ketika kita menjadikan objek tulang sebagai target, maka kolom Bone akan muncul untuk 
digunakan memilih secara spesifik bagian tulang mana yang akan dijadikan target.

Pole Target
Objek yang digunakan sebagai rotasi tiang.

Iterations
Nilai maximum untuk memecahkan iterasi

Chain Length
Berapa banyak tulang yang akan dikenakan oleh efek IK. Jika nilainya “0” maka seluruh tulang akan 
terkena efek dari IK.

	 Use Tail: Memasukan ekor dari Bone sebagai element terakhir dari susunan rantai tulang 
	 yang terkena efek IK.
	 Stretch: Mengaktifkan IK stretching

Weight
	 Position: Berat dari posisi kontrol untuk target IK
	 Rotation: Susunan tulang mengikuti rotasi dari target



Latihan
Buka fileInverse Kinematic.blend, untuk mencoba membuat constraint IK.



Latihan
1. Buka file “Latihan IK.blend”
Buatlah tulang untuk menggerakan 2 buah bola mata dengan menggunakan constraint Inverse 
Kinematic dan Limit Location

2. Buat sebuah objek tulang.

Mode	 : Object Mode
Menu	 : Add > Armature > Single Bone
Hotkey	 : Shift + A > Single Bone



3. Pindahkan 3D Cursor ke center point mata kiri

Mode	 : Edit Mode (Mata)
Seleksi	 : Lingkaran tengah mata
Menu	 : Mesh > Snap > Cursor to Selected
Hotkey	 : Shift + S > Cursor to Selected

4. Tambahkan tulang baru di lokasi 3D Cursor 
berada

Mode	 : Edit Mode (Armature)
Seleksi	 : Lingkaran tengah mata
Menu	 : Add > Snap > Cursor to Selected
Hotkey	 : Shift + S > Cursor to Selected



5. Lakukan lagkah yang sama untuk membuat tulang mata bagian kanan

a. Aktifkan X-Axis Mirror 
pada armature properties 
di sebelah kiri jendela 
kerja

b. buat tulang untuk mata kiri dan mata kanan

c. Properti untuk tulang mata kanan d. Properti untuk tulang mata kiri



6. Ganti posisi tulang mata kanan dan kiri seperti pada gambar.

7. Buat 3 buah tulang baru dengan posisi dan properti seperti pada contoh.



7. Berikan constraint pada tulang mata.R, mata.L dan Kontrol Mata, dengan setting constraint 
seperti pada contoh.

a. IK constraint untuk Mata.R a. IK constraint untuk Mata.Lb. Limit Location untuk kontrol 
mata


